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About this Guide

>

This topic contains important information about the purpose, content, context, and intended
audience for this document.

Product Documentation

This document is part of the Niagara technical documentation library. Released versions of Niagara
software include a complete collection of technical information that is provided in both online help
and PDF format. The information in this document is written primarily for Systems Integrators. In
order to make the most of the information in this book, readers should have some training or
previous experience with Niagara 4 or NiagaraAX software, as well as experience working with JACE
network controllers.

Document Content

This document describes the procedures used to create an OPC UA Server in a station for the purpose
of exposing control points, alarms, and histories to OPC UA clients. This document also describes the
procedures used to create an OPC UA Client in the station which provides connectivity to OPC UA
Servers for the purpose of integrating Opc UA data into the Niagara Framework for monitor and
control operation.

Related Links

e Document change log
e Related documentation
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About this Guide

Document change log
Changes to this document are listed in this topic.
e December 19, 2017: Initial publication

Related Links

e About this Guide (Parent Topic)

Related documentation

This topic lists documents that are related to this guide.

¢ Niagara Drivers Guide
¢ Niagara 4 Platform Guide

Related Links

e About this Guide (Parent Topic)
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Overview

OPC is the interoperability standard for secure and reliable data exchange in the industrial
automation space, as well as other industries. The OPC standard is a series of specifications that
define the interface between Clients and Servers, as well as Servers and Servers, including access to
real-time data, monitoring of alarms and events, access to historical data and other applications.

The OPC standard, initially restricted to the Windows operating system, derives its acronym from OLE
(object linking and embedding) for Process Control. These specifications are now known as OPC
Classic. The OPC Unified Architecture (UA) is a platform independent service-oriented architecture
that integrates all the functionality of the individual OPC Classic specifications into an extensible
framework.

The Opc UA Driver is the Niagara implementation of this service-oriented architecture.
Related Links
e Driver component model

e Requirements
e Compatibilities

Driver component model

The OPC UA Server driver and the OPC UA Client driver both follow the Niagara Driver Framework
model.

OpcUaServer driver component model

The two main components are the OpcUaServer and OpcUaNamespace. The OpcUaServer
component is used to model an Opc UA Server instance in the driver framework. There should be
only one instance of the OpcUaServer in a station. The OpcUaNamespace component is used to
model an Opc UA Namespace in the parent OpcUaServer. It is typically used to provide a logical
grouping of OPC UA variables, histories, and events that can be accessed by an OPC UA client.

OpcUaClient driver component model
The primary OpcUaClient driver components are:

e OpcUaNetwork is the parent container for all of Opc UA Client devices being modeled.

e OpcUaDevice: is the Niagara representation of an Opc UA Client.

¢ OpcUaClientPointDeviceExt is the device extension that contains proxy control points used to
proxy values to and from the Opc UA Server.

e OpcUaClientAlarmDeviceExt is the device extension provides the ability to subscribe to alarm
events from the Opc UA Server.

¢ OpcUaClientHistoryDeviceExt is the device extension provides the ability to import histories
from the Opc UA Server.

e OpcUaClientProxyExt is the control point proxy ext used to identify a specific Opc UA Server
data variable to proxy through this control point.

e ImportHistoryExt is the history point extension that is used to import the history data
associated with the specific Opc UA Server data variable defined in the proxy ext.
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Related Links

e QOverview (Parent Topic)

Requirements

This topic describes the licensing and software requirements for using the Niagara OPC UA Driver.

Software requirements

The Niagara OPC UA Server and Client Drivers are available for Niagara 4.3 or later.

OPC UA Server driver required modules

The following modules must be installed on the host in order to use the OPC UA Server driver.

e opcUaCore-rt — contains Java Class files and resources common to both OPC UA client and
OPC UA server functionality.

e opcUaServer-rt — contains Java Class files and resources that support OPC UA Server run-time
functionality.

e opcUaServer-wb — contains Java Class files and resources that support OPC UA Server
Workbench functionality.

OPC UA Client driver required models
The following modules must be installed on the host in order to use the OPC UA Client driver.

e opcUaCore-rt — contains Java Class files and resources common to both OPC UA client and
OPC UA server functionality.

e opcUaClient-rt — contains Java Class files and resources that support OPC UA Client run-time
functionality.

¢ opcUaClient-wb — contains Java Class files and resources that support OPC UA Client
Workbench functionality.

License Requirements

The opcUaClient module is a licensed feature. You must have a target controller host that is licensed
with the “opcUaClient” feature. In addition, other OPC UA Client device, proxy point, or history limits
may exist in your license.

The opcUaServer module is a licensed feature. If intending to serve data via OPC UA you must have a
target controller host that is licensed with the “opcUaServer” feature. Additionally, other OpcUa
Server device limits or proxy point limits, or history limits may exist in your license.

You can check to see if your software installation is licensed for opcUaClient and/or opcUaServer by
opening the license file from the License Manager view. The feature name is present only if your
platform is licensed for the feature, as shown here:

< feature name="opcUaClient" expiration="2020-12-31" history.limit="" point.limit=""
device.limit=""/ >< feature name="opcUaServer" expiration="2020-12-31" history.limit
device.limit=""/ >
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Related Links

e QOverview (Parent Topic)

Compatibilities

OPC UA is a platform-independent, service-oriented architecture specification. It integrates all
functionality from existing OPC Classic specifications, providing a more secure and scalable solution.
The specification is backwards compatible with OPC Classic.

Operating systems

The OPC UA driver software functions on QNX-based controllers or Windows operating systems,
starting with Windows 7 Service Pack 1 and later.

Niagara Platforms
The OPC UA driver software functions on any QNX-based platform running Niagara 4.3 or later (ex.,

JACE-8000), as well as Windows based platforms running Niagara 4.3 or later, such as a PC licensed
for the OPC UA Client and/or OPC UA Server.

Related Links

e Supported Opc UA profiles
e Supported OPC UA facets

e Qverview (Parent Topic)

Supported Opc UA profiles

UA Generic Client Profile

UA Data Access Client Profile

UA History Data Access Client Profile
UA Alarm

Related Links

e Compatibilities (Parent Topic)

Supported OPC UA facets

The following table lists the OPC UA Client facets supported by the Niagara OPC UA driver. Note that
this is a subset of available OPC UA facets.

OPC UA Facet Description

Base Client Behavior Facet This Facet indicates that the Client supports behavior that Clients
shall follow for best use by operators and administrators. They
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OPC UA Facet Description

include allowing configuration of an endpoint for a server without
using the discovery service set; Support for manual security setting
configuration and behavior with regard to security issues; support
for Automatic reconnection to a disconnected server.

Core Client Facet This Facet defines the core functionality required for any Client.
This Facet includes the core functions for Security and Session
handling.

AddressSpace Lookup Client Facet This Facet defines the ability to navigate through the AddressSpace

and includes basic AddressSpace concepts, view and browse
functionality and simple attribute read functionality.

Attribute Read Client Facet This Facet defines the ability to read Attribute values of Nodes.

DataChange Subscriber Client Facet This Facet defines the ability to monitor Attribute values for data
change.

DataAccess Client Facet This Facet defines the ability to utilize the DataAccess Information

Model, i.e., industrial automation data like analog and discrete data
items and their quality of service.

Alarm and Event Client Facet Partially supported.

This Facet defines the ability to subscribe for Event Notifications.
This includes basic AddressSpace concept and the browsing of it,
adding events and event filters as monitored items and adding
subscriptions.

Method Client Facet This Facet defines the ability to call arbitrary Methods.
Historical Access This Facet defines the ability to read, process, and update historical
data.

Related Links

e Compatibilities (Parent Topic)
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Opc Ua Server tasks

The following topics describe how to set up an OPC UA Server, add server points with alarm and
history extensions, and configure the server for OPC UA Client users.

Following are Opc Ua server tasks.

Related Links

Setting up the OPC UA Server

Adding a server point with alarm and history extensions
Configuring the server to support an Opc Ua Client user
Verifying set up using client simulation software

Setting up the OPC UA Server

This procedure describes the steps to set up the OPC UA Server on the station.

Prerequisites:

e opcUaCore-rt and opcUaServer (-rt,-wb) modules are installed
e Connected to the station

e opcUaServer palette is open

e |nternet connectivity

NOTE: If you intend to install only the OPC UA Client driver then skip ahead to the chapter, “OPC UA
Client tasks”.

The example client used in this procedure is the ProSys Simulation OPC UA Client. However, many
other simulation OPC UA clients are available. Typically in an actual job, other 3rd party OPC UA
clients will connect to the Niagara OPC UA Server installed on your station.

Perform the following steps:

1. Confirm that the JACE controller is licensed with the “opcUaServer” feature.

2. Add the OpcUAServer component from the palette to the Drivers folder in the station (Station
> Config > Drivers).
The OpcUaServer is added to the station. By default, the Enabled field is True, and if this is the
initial server setup then server Status will likely be {ok}.

3. Add an OpcUaNamespace component to the OpcUaServer (either drag from the palette or
double-click on the OpcUaServer to open the Opc Ua Server Device Manager view and click
New > OK.

A second New dialog appears containing several component configuration fields.

4. Configure the following fields as needed and click Save.
e Name: enter a name for the server’s Namespace or use the default name.
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e Type: Opc Ua Namespace is the default type and the only available option.
e Namespace Url: [use the default value ].
e Enabled: true by default.
The new namespace appears in the view.
5. In the Nav tree, right-click on the added OpcUaServer component to open a property sheet
view and note the server’s Opc Tcp Connection Address value, as shown.

(@l OpcTcp Endpoint Opc Tecp Endpoint

[l User Authentication Methods  [#] Anonymous [ Username/Password

(@l Max Session Count 500

[l Max Session Timeout +00000n 05m 0033

[i Max Subcription Count 50

m Opc Tep Connection Address opc.tcp://IE3BLT1GKS6C2.global .ds. honeywt
UM Server Info Opc Ua Build Info

0 Session Info Mo active sessions

This connection address is required by any OPC UA Client attempting to connect to the server.

NOTE: The port specified in the Opc Tcp Connection Address may be blocked by your PC/
network firewall. The firewall settings may need to be adjusted to allow data transfer on this
port.

The OPC UA Server set up is complete. For any OPC UA Client connection to succeed, the client must
be configured with the server’s Opc Tcp Connection Address, as well as a Security Mode, Security
Policy, and User Authentication method allowable by the server.

NOTE: Username and password values also must be defined in the station’s UserService.
Related Links

e Opc Ua Server tasks (Parent Topic)

Related References

e opcUaServer-OpcUaServer

opcUaServer-OpcUaNamespace

Adding a server point with alarm and history extensions

This procedure describes how to add server point with alarm and history extensions. Server points
provide live and historical data as well as alarm events. Server points are visible to a connected OPC
UA clients. Note that this procedure assumes that the station does not already have control points
available.

Prerequisites:

e Connected to a station with configured OpcUaServer driver
e opcUaServer palette

11
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NOTE: Adding a history extension to a control point in the OpcUaServer's Namespace makes the
associated history visible to a connected OPC UA client. Similarly, adding an alarm extension to a
control point in the OpcUaServer's Namespace and setting the alarm extension's AlarmClass to
OpcUaAlarmClass sends OPC UA events to a connected OPC UA client that subscribes for these
events.

Perform the following steps:

1. Inthe Nav tree, click to expand the OpcUaServer and OpcUaNamespace components.
2. In the Points Folder under the OpcUaNamespace, add an OpcUaServerPointFolder from the
palette.

- Nav

E@ o @ My Network

| e OpcllaServer

v ; OpcllaMamespace
> °Alarm50urcelnfo

v Q Points

~ [ opcuaserverPointFolder

3. Under the station Drivers folder, add a new NumericWritable point and configure the point
with a NumericCov history extension and an OutOfRangeAlarmExt alarm extension.

4. Double-click the OpcUaServerPointFolder to open the Opc Ua Server Point Manager view, click
Discover, and in the ORD selection select the folder to search and click OK.
The Discovered pane presents a list of control points that exist in the station that can be
mapped to the OpcUaServerPointFolder.

5. Select the NumericWritable in the Discovered pane and click Add.
The point is added to the Database pane and becomes visible under the
OpcUaServerPointFolder, as shown here.

File Edit Search Bookmarks  Tools  window  Manager  Help Q
4 O 0- o CB O - 2 % © 0O B X E Y 3 (=N »
: Station (Opcua_o1) : config  : Drivers  : OpcUaServer  : OpcUaNamespsce : OpcuaserverPointFolder : OpcUa Server Point Manager ~
% | Logic A OpcUaserverPointFolder

P o &) My Network & OpcUa Server Discovery Success 3 [X]

© opcuaserver Discovered & objects

~ @ OpcUaNamespace Point Direction  Peint Type ]
» © alarm sourceInfo
v @ roints
~ [ OpcUaserverPaintFolder
» ) Numericwritable_01
» () Numericwritable_o2
b © Eooleanwritable_o1 Eoslot/Losic/Random 02 Exoort  kitControlRandom
» ©alamed Database 3 objects
 opcuanetwork T

slot:/Logic/NumericWritable_01  Export control:NumericWritable
B slot/Logic/Sinewave_01 Export kitControl:SineWave
B slot:/Logic/Multivibrator Export kitContro:Multivibratar

slot:/Logic/BooleanWritable_01  Export control:BooleanWritable

Name Out Ua Node Id Local Point B
() Numericwritable_01  62.2 {unackedAlarm} @16 ns=2;s=points/OpclaServerPointFalder/Numericiritable_01  sloty/Logic/Numericiiritable_
- Palette

NumericWritable_02 (88.6{alarm,unackedAlarm} @ 16 |ns=2;5=points/OpclaServerPointFolder/NumericWritable_02 |slot:/Logic/NumericWritable

W [X] B @ opcuasserer @ Booleanwritable_01  true{ok] @ 16 ns=2;s=points/OpclaServerPaintFolder/BaaleanWritable_01  slot:/Logic/BaaleanWritable_

» A opcUaserverPointFolder
» L[4 opcusalermclass
) @4 OpcUsAlarmRecipient
BE New Folder ‘ [2) New ‘ # Edit  §4 Discover M cancel = (¥ Add »* Match B, Tagit

By default, a discovered writable point has the “Export” direction, the point is exported from
the Server as read-only. However, you can add a writable point that has the “Import” direction,
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the point (which is writable by the Client) is imported to the Server which is able to read the
data from the Client. To do this, expand the writable point in the Discovered pane and select
the point with a Direction value of “Import” and click Add.

After adding the point in the server, you can add Niagara history or alarm extensions to enable
histories or alarms for the point.

The server points in this OpcUaServerPointFolder are served up as consumable data, including live
and historical data and alarm events, that is visible to a connected OPC UA client.

Related Links

e Opc Ua Server tasks (Parent Topic)

Related References

opcUaServer-OpcUaServerAlarmDeviceExt

Configuring the server to support an Opc Ua Client user

This procedure defines a user for third party Opc Ua Clients when connecting to the Niagara
OpcUaServer. The authentication scheme assures that the identity of a user can be verified and may
use roles to limit user access only to certain areas. User authentication is achieved when the client
passes user credentials to the server which is already configured for that user. Any new OPC UA client
users should be authenticated via the Opc Ua Authentication Scheme.

Prerequisites:

e Connected to a running station, already configured with the OpcUaServer
e The opcUaServer palette is open

NOTE: When making any server-side changes on the OPC UA Server, you must first disable and then
re-enable the server.

Perform the following steps:

1. Inthe Nav tree, expand the station’s Config and Drivers nodes, and open a Property Sheet view
on the OpcUaServer component.
2. Under the Enabled property, click on the dropdown list and click false.
The OpcUaServer is disabled.
3. Inthe Nav tree, expand the station’s Services and AuthenticationService nodes.
4. Drag the OpcUaAuthenticationScheme component from the opcUaServer palette to the station
Authentication Schemes subfolder under AuthenticationService, as shown here.
0 AuthenticationService
0 Authentication Schemes
ﬁDigestScheme
ﬁ AXDigestScheme
& OpcUahAuthenticationScheme
mSSO Configuration

5. Double-click UserService node to open the User Manager view.

13
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6. In the User Manager view, click New and in the New popup window click OK to add a single
new user.
7. In the second New window, configure these properties:
a. Enter a user Name
b. Under Authentication Scheme Name, click the dropdown list and click on the
OpcUaAuthenticationScheme.
c. Inthe Password and Confirm fields, enter a strong password.
A strong password requires at least 10 characters, plus at least one of each of the
following characters: lowercase, uppercase, and a digit.

NOTE: If you use the same default password for all new users be sure to set the Force
Reset At Next Login value to “true”.

8. Click Ok.
9. Under the station Drivers node, re-open a Property Sheet view on the OpcUaServer
component, and set Enabled value to true and click Save.

Related Links

e Opc Ua Server tasks (Parent Topic)

Related References

opcUaServer-OpcUaAuthenticationScheme

Verifying set up using client simulation software

This procedure describes the steps to verify the OpcUaServer set up using the ProSys OPC UA Client
software. Several other OPC UA Clients are available. The basic procedure would remain the same.

Prerequisites:

Connected to the station

Configured N4OpcUaServer

OPC UA Client simulation software installed and running
Internet connectivity

Perform the following steps:

1. Inthe OpcUaServer Property Sheet view, copy the Opc Tcp Connection Address, as shown.

Max Subcription Count 50
fi Opc Tep Connection Address opc.tcp://IE3BLT1GKS6C2 .global.d3. honeyw: |

UM server Info Opc Ua Build Info

NOTE: The port specified in the Opc Tcp Connection Address may be blocked by the PC/
network firewall. The firewall settings may need to be adjusted to allow data transfer on this

port.
2. In the simulation client window, paste the Opc Tcp Connection Address (copied in step 1) into

the available field, as shown.

14
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-
Prosys OPC UA Client

=i S |

[(NewTab | |

Select server and connect

e e

Disconnected | opC.tep/taErE L. -l.l.l-ds.Iloneywell.com:52520rOPCUNN40chaSewer| I ‘V l:‘.) S & ?
z l/ Attributes and References | ¢
: | &" uﬂn"Fomard |v|

Reference

| TargetDisplayMame

. Click on Security Options () and select a security mode and security policy setting as

-
Security Settings

() Basic256
® Sign & Encrypt

Security Policy
Security Mode
= ) None
) None | 0Ok
() Basic128RSA15
) Sign

(@ Basic256 SHA256

[] Show only modes that are supported by the server

Cancel

required by the server, for example Sign & Encrypt and Basic256SHA256, and click Ok.
i

4. Click on User ID (I@) and select a user authentication mode as required by the server, for
example: Username and Password, enter a valid username and password and then click Apply.

p
Select User Authentication Mode

(o

) Anonymous ® Username and Password (' Certificate and Private Key

Cance

Username: |0chaUser

| Password:

NOTE: The Username and Password values must be for a valid username and password that is
defined in the station's Users Service.

5. Click Connect () to connect to the server.

The client successfully connects to the OpcUaServer. In the example shown, expanded Objects reveal
the OPC UA Namespace with Server points and the right-side Data View tab allows you to monitor
data values for selected points.
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— -
Prosys OPC UA Client u b

F N40pcUaServer@: &5 8 1 &7 11 global.ds.honeywell.com EH]
(|
Running P> & opcUalser ?
; [ Attributes and References | Data View 3 |
) E Objects [v] Enabled Puhlishinglntenra“mﬂﬂ.ﬂ
T ﬂ OchgNamespace # Mode Id Display Name | Value | Datatype Source Timestamp Server Timestamp | Statuscode
@ points ) 0 |ns=2;s=poi.. [NumericWritable [99.242_|Number  |14.03.2017 17:01:14.0..[14.03.2017 17:01:14.... |GOOD (0x00...
? ﬂOchaSer\ferF’otholder 3
I o= 1 BooleanWritable :
o | Numeric\Writable
o M Server
o= Types
Views

Related Links

e Opc Ua Server tasks (Parent Topic)

Related References

e Third-party simulation software
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Opc Ua Client tasks

The following topics describe how to set up the OPC UA Client, connect to an OPC UA Server, discover
and add points with alarm and history extensions, and subscribe for OPC UA alarm events.

Following are OPC UA client tasks.
Related Links

Adding the OPC UA Network

Connecting to an OPC UA Server

Discovering OPC UA Server Points

Adding Points to the Station database

Adding points containing OPC UA Histories

Adding control point to invoke an OPC UA Method
Adding Points for OPC UA Object Arrays

Adding an OPC UA Folder with child OPC UA Variables
Importing OPC UA Histories without using a Control Point
Subscribing for OPC UA Alarm Events

Adding the OPC UA Network

This procedure describes steps to add an OPC UA Network to the station.

Prerequisites:

opcUaCore-rt and opcUaClient (-rt, -wb) modules are installed
Controller is licensed with the opcUaClient feature
Connection to the station

opcUaClient palette

Internet connectivity

Perform the following steps:

1. Inthe Workbench the Nav Tree, expand the Station > Config nodes and double click on Drivers.
2. In the Driver Manager view, click on the New button.
3. In the New dialog, select OpcUaNetwork from the dropdown list and click OK.

The OpcUaNetwork is added to the station, and appears in the Driver Manager view. By default, the
Enabled field is True, and if this is the initial network setup then network Status will likely be {down}
until an OpcUaDevice is added and server connection data is configured.

Related Links

¢ Opc Ua Client tasks (Parent Topic)

Related References

e opcUaClient-OpcUaNetwork
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Connecting to an OPC UA Server

This procedure describes steps to add an OpcUaDevice to the network and configure the device to
connect to an OPC UA Server.

Prerequisites:

opcUaCore-rt and opcUaClient (-rt, -wb) modules are installed
Controller is licensed with the opcUaClient feature
Connection to the station

opcUaClient palette

Internet connectivity

NOTE: The example server used for this procedure is the ProSys Simulation Server. However, it is
more likely that you will open a connection to an OPC UA Server known to you that serves-up actual
historical and live data.

Perform the following steps:

1. Identify and copy the server’s Opc Tcp connection address (opc.tcp://*), as well as the required
security mode and user authentication method.

For example, when using the ProSys Simulation Server copy the connection address from the
Server Status screen, as shown here.

F ™
R Prosys OPC UA Simulation Server E@ﬂ

Help

Status | Endpoints | Users | Sessions | Ceriificates | Connection Log | Address Space | Simulation | Debug Log | Reg/Res Log

OPC UA

Simulation Server

Server Status: Running
SIM ICon nection Address (UA TCP): pc.tepMIEG7DTDVY XX C2 global.ds.honeywell.com:53530/0PCUA/SIimulationServe
Connecfion Address (HTTPS):  hitps/IEG7DTDVYXXC2 global.ds honeywell com:53443/0PCUA/SimulationServer
i
PROSYS @ Current Server Time: 2016-09-27 12:09:03+0530
Server Starting Time: 2016-09-27 12:08:30+0530
Running ve.2.2-109

NOTE: Within Niagara the default configuration for the OPC UA Server and Client is security
mode “Sign and SignEncrypt” and security policy “Basic256SHA256”. These are the
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recommended settings for high security. Other security policies and modes are supported
within the Niagara OPC UA driver with a warning that alerts users to the security risk involved.
The user or administrator must acknowledge this alert to proceed and this is logged in the
system for audit purposes.

2. In the Workbench the Nav Tree, expand the Station > Config > Drivers nodes and double-click
on the OpcUaNetwork.

3. In the Opc Ua Client Device Manager view and click on New to add a new device.

4. In the New dialog, select the OpcUaDevice from the dropdown list and click OK.

A second New dialog appears containing several device configuration fields.

5. Configure the following fields and click OK.
e Server Endpoint Url:enter the OPC UA Server’s Connection Address (identified in
step 1)
e Security Mode: by default this is set to “Sign Ecript Basic256 Sha256”. The value
must match the server’s Security Mode configuration.

NOTE: The default Security Mode configuration for both OPC UA Server and Device is
“Sign Ecrypt Basic256 Sha256” which means security modes Sign and Encrypt with
security policy EncryptBasic256SHA256.

e User Authentication Mode: select an option available from the dropdown list, as
required by the server. For example used here, the Prosys simulation server is configured
for Anonymous user, as shown. Note that if you select the option “User Name And
Password” then you must enter the credentials as they are configured on the server.

e Certificate: by default the value is “tridium”. The value must match the server’s

Certificate configuration.
Once the server endpoint URL is entered and you click OK, the driver automatically attempts to

opena connection to the server.

-
4 New M
Name Type Server Endpoint Url  Security Mode Certificate Enabled F
; OpcUaDevice OpcUaDevice opctep://IEGTDTOVYIO None tridium true
F‘ Name OpclUalevice
(gl Type Opc Ua Device

[l Server Endpoint Url opc.tcp://IE6TDIDVYHEC2.global.ds. honevw Ao

F‘ Security Mode MNone
(@i certificate tridium
F‘ Enabled . true

OK Cancel

You can confirm that the connection to the server was successful by inspecting the property sheet of
the OpcUaDevice. The Server State property should indicate “Running” and the Server Current Time,
Server Start Time, and Server Info properties should be populated with the current values.

Related Links

e Opc Ua Client tasks (Parent Topic)
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Related References

e opcUaClient-OpcUaDevice

Discovering OPC UA Server Points

This procedure describes how to start a discover job that interrogates the connected OPC UA Server
to discover the OPC UA objects being served up.

Prerequisites:

e Connected to an OPC UA Server

Perform the following steps:

1. Inthe Nav Tree, expand the Station > Drivers > OpcUaNetwork > OpcUaDevice node.
2. Right-click on the Points node and select Views > Opc Ua Client Point Manager to open the

view.
; OpclaDevice
[+ JAT Views » Opc Ua Client Point Manager
fero
m > AX P rt
AX P y -
0 Alg New R
9 Wire Sheet
i Edit Tags
O +is Property Sheet
Apps Make Template Category Sheet
& Files AX Slot Sheet
[&] Hierarchy Copy Relation Sheet

3. In the Opc Ua Client Point Manager view, click on the Discover button.

v ] /‘ OpcUa Client Discovery Success )) E]
Discovered 7 objects
Ua Display Name Ua Node Id Access Level  Array Dimension  Array Index Ua Data Type Ua Data Type ldentifier B
Bl Objects =85 i -1 f
O server i=2253 o -1 f
O MyObjects ns=2;s=MyCbjectsFolder I -1 f
O StaticData ne=3;s=StaticData I -1 f
ONonUﬁNodemmpl\ﬁnceTest ns=&s=NonUaNodeComplianceTest [} -1 f
0 Simulation ns=5;5=85/0:Simulation i -1 f
0 MyBighodeManager ns=6;5=MyBigNodeManager { -1 f
Database 0 objects
Name Type Out UaMNodeld Arrayindex Ua Status Code Tuning Policy Name B

IE New Folder | Bﬂew | # Edit nDimver B Cancel @Add »Match T, Tagit
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You can browse the discovered objects by expanding the items in the Discovered pane.

Rel

Rel

This starts a discovery job that communicates with the OPC UA Server to discover the object

structure in the server.

ated Links

e Opc Ua Client tasks (Parent Topic)

ated References

e opcUaClient-OpcUaDevice

Adding Points to the Station database

This procedure describes how to add control points to the station for selected discovered objects.

Prerequisites:

e Discovered points on the OPC UA server are visible in the Opc Ua Client Point Manager view.

Perform the following steps:

1. Inthe Opc Ua Client Point Manager view, expand the items in the Discovered pane and select

w N

an object to add.

° /‘ Opc Ua Client Discovery

e TR -

11

Success >> B]

12 objects

Discovered
Ua Display Name Ua Node Id Access Level  Array Dimension  Array Index Ua Data Type Ua Data Type Identifier B
= objects i=85
O server i=2253
= 0 MyObjects ns=2;==MyObjectsFolder
=] 0 MyDevice ns=2;5=MyDevice
0 MyEnumObject ne=2:z==MyEnumObject {rw} Integer
@ MyLevel nz=2:z=MyLevel {rwhr} Double
ﬂﬁ MyMethod ns=2;s=MyMethod
Q MySwitch ns=2;5=MySwitch {rwhr} Boolean
0 StaticData ns=3;5=5taticData

Click the Add button (or double-click on the selected object).
. In the Add dialog, click OK to add the point to the Database.

The added point is entered into a subscribed state and it begins updating with real-time values,

as shown here.
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@/ DpcUaClient Discovery

Success >> [g]

12 objects

Access Level Array Dimension Array Index Us Data Type Ua Data Type Identifier B

Discovered
Ua Display Name Ua MNode Id
Bl Objects i=85
O server 1=2253
= OMyOhjEcts ne=2:==MyOhjectsFolder
= OMyDevice ns=2;5=MyDevice
QMyEnumObject ns=2;5=MyEnumObject {rw}
- MyLevel ns=2;s=MyLevel {rwhr}
oa MyMethod ne=2:z==MyMethod
QMy&Nitch ne=2:z=MySwitch {rwhr}

OStaticData ns=3;5=5taticData

Database
Name Type Out Ua MNode Id

QMyLevel MumericPoint  88.00{ok] ns=2;s=MyLevel

Array Index Ua Status Code Tuning Policy Name

GOOD (0x0000000( defaultPolicy l

-1

-1

-1

-

Integer -1

Double 11
-1

Boolean 1

-

1 objects

B

NOTE: If the OPC UA object has engineering units, precision, and/or range information
configured, it will attempt to configure the point’s facets to match. This may not always be

possible.

Also, if the type of the selected object is writable, then you can change the point Type to be

writable type, as shown below.

ﬁ Tuning Policy Name Default Folicy
[l Device Facets

m Conversion .E Default

r B
43 Add S
Name Type Ua Node Id Array Dimensions  Array Index Enabled Facets
0 MyLevel MNumericPoint ns=2:z=MyLevel true units=null precizion=2, min=-inf,max=+inf ¢
ﬁ Name MyLevel
(il Type Numeric Point
l ﬁ Ua Node Id Numeric Point =B
Numeric Writable
ﬁ Array Dimensions
m Array Index K_?
ﬁ Enabled . true
m Facets units=null,precision=2,min=-inf,max=+inf >> m -

units=nullprecizion=2, min=-inf,max=+inf >) ’9 -

0K Cancel

Related Links

e Opc Ua Client tasks (Parent Topic)
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Related References

e opcUaClient-OpcUaDevice

Adding points containing OPC UA Histories

If the OPC UA object being added has an OPC UA history, the point added to the station will
automatically include a history extension (ImportHistoryExt).

Prerequisites:

e Discovered objects with histories on the OPC UA server visible in the Opc Ua Client Point

Manager view.

The OPC UA objects that have histories can be identified in a couple of ways:

e A triangular history badge will be placed over the icon of the OPC UA object in the Discovered

pane: - MyLevel

¢ In the Discovered pane, the Historizing column value will be true.

Perform the following steps:

1. In the Discovered pane, locate and select one or more objects with histories, as shown here.

& /* Opcuaclient Discovery

Discovered
Ua Display Name

Bl Objects

Ua MNode Id Access L¢

=85

O server i=2253
= OM}'Objects ns=2:z==MyObjectsFolder
= OM}'DEViEE ns=2:s=MyDevice
MyEnumObject ns=2;==MyEnumObject {rw}
| oA MyLevel ns=2:s=MyLevel {rwhr} I
nQ MyMethod ns=2;5=MyMethod {
| Q MySwitch ns=2;s=MySwitch {rwhr} l

The default history extension period for uploading history data is once in 10 minutes. This can be
modified via the Execution Time property, by changing the Interval value, if required.

From the History extension you can also view the history data, as shown here.
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\‘* Opclaetwork

@ OpcUaDevice
0 Alarm Source
E‘- Pall Schedule]
.. Serverinfo
0 Alarm Ext
0 Points

MyLevel

Q Pro:

» G

© Histories

Wl serverRoot

Related Links

] AXProperty Sheet

Actions

Edit Tags

Make Template Wire Sheet

Property Sheet
Category Sheet
AX Slot Sheet

e Opc Ua Client tasks (Parent Topic)

Related References

opcUaClient-OpcUaClientHistoryDeviceExt

Adding control point to invoke an OPC UA Method

The driver provides a means of invoking OPC UA Method objects defined in a OPC UA server. A
discovered OPC UA Method can be identified by clicking ¥ MyMethod |

Prerequisites: The discovered objects on the OPC UA server are visible in the Opc Ua Point Manager

view.

Perform the following steps:

1. Select an Opc Ua Method and click Add.
It adds an OPC UA Method in the Discovered pane. The added control point will have a
callMethod action.

2. Right-click on the Opc Ua Method and click Actions > Call Method.

F ™
4% Call Method ==
(Wl Vector

m desco rhe operation to perform on parameter: valid functions are s3in, 1
(@i valued |tan
m descl The parameter for operation
(@ value1 45.00
0K Cancel

If the OPC UA Method has defined input arguments for the method, a Call Method dialog will

be displayed for the arguments. It will have a descriptor that describes each of the arguments.

You may need to scroll the descriptor to see the complete text.
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3. In the Call Method dialog, enter the desired argument values and click OK.

Database
Name Type Out Ua Node Id Array Index Ua Status Code Tuning Policy Name
e MyMethod OpclUaMethod 1.00{ck} ns=2;s=MyMethod defaultPolicy

NOTE: The OpcUaMethod control point is a subclass of BStringPoint. The out property will be a
StatusString type. The data type of the method return value may not be a String. In addition to
setting the out property by converting the method results to a string, it will also add a “result”
property of the appropriate BStatusValue type.

This invokes the method in the OPC UA server with the provided arguments.

On completion, the added value will be reflected and displayed in the Out property for the control
point.

Related Links

e Opc Ua Client tasks (Parent Topic)

Adding Points for OPC UA Object Arrays

A discovered OPC UA object that is an array can be identified by: @/ BooleanAray you can select
and add one or more items from the discovered OPC UA object array.

Prerequisites: Discovered Boolean array objects on the OPC UA server visible in the Opc Ua Client
Point Manager view.

Perform the following steps:
1. Click to expand a BooleanArray object to display the list of items.
2. Select one or more items and click on the Add button.

A single control point is used for an individual array item. The “Array Dimension” column
indicates the size of the array. The Array Index is automatically set based on the selection.
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& A~ Opcuaclient Discovery

~
Discovered Bl Ao
== Mame Type Ua Mode Id Array Dimensions  Array Index Enabled Facets
Y Dataltems © BooleanAmrayo Point leanArray  [5] o true
D Multistateltems ) BocleanArrayl Boolean Point  ns=3;5=BooleanArray  [5] 1 true
D staticarrayVariab © BooleanArray2  Boolean Point  ns=3:s=BooleanArray  [5] 2 frue
& @l Booleanara ) Booleanarray3  Boolean Point  ns=3;s=Booleanarray  [5] 3 frue
O Bocleand) © Booleanarrays  Boolean Point  ns=3;s=Booleanarray  [5] 4 true
© socleanl (gl Name BooleanArray0
2 Booleand| (gl Type Boolean Point
© sooleant [§l Ua Node 1d ns=3; s=Booleankrray a2
) Booleand|| -
P (gl Array Dimensions [5]1 A=
&7 ey testringar [l Array Index o A2
J|| | [l Enabled ® true
Database (il Facets » O~
ﬁyp{ [l Tuning Policy Name |Default Folicy
[l Pevice Facets > D -

) MyLevel Numfl

(@l Conversion

=
S Default

oK Cancel

The selected points are added to the Database.

Database

Name Type

o BooleanArray0 Boolean Point
o BooleanArrayl Boolean Point
o BooleanArray2 Boolean Point
o BooleanArray3 Boolean Point

o BooleanArray4 Boolean Point

Related Links

Out Ua Node Id

truefok} n==3;=BooleanArray
false{ok} n==3;==BooleanArray
truefok} n==3;=BooleanArray
false{ok} n==3;==BooleanArray
false{ok} n==3;==BooleanArray

Array Index Ua Status Code

0 GOOD (0x00000000) "
1 GOOD (0x00000000) "
2 GOOD (0x00000000) "

3 GOOD (0x00000000) "

4 GOOD (0x00000000) "

Tuning Policy Name
defaultPolicy
defaultPolicy
defaultPolicy
defaultPolicy

defaultPolicy

e Opc Ua Client tasks (Parent Topic)

Adding an OPC UA Folder with child OPC UA Variables

5 objects

®

It is possible to add multiple control points at once by adding a discovered OPC UA Object Folder to
the station. Note that the collection of control points must be in a discoverable container.

Prerequisites: One or more discovered OPC UA Object Folders on the OPC UA server visible in the Opc
Ua Client Point Manager view.

Perform the following steps:

1. Select a Discovered Opc Ua Object Folder and click on Add by double-clicking on the discovered
row or by selecting and clicking the Add button.
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° /‘ OpcUa Client Discovery Success >) E]
Discovered 15 objects
Ua Display Name Ua Node Id AccessLevel Array Dimension Array Index Ua Data Type  Ua Data Type Identific B
OMyObjects ns=2:5=MyObjectsFolder { -1
= OStaticData ns=3;5=5taticData i -1
OAccessLevels ns=3;s=AccessLevels i -1
OAnalogItemArrays ns=3;z=AnalogltemArrays i -1
OAnalogItems ns=3;s=Analogltems i -1
o Dataltems ns=3:5=Dataltems {1 -1
o MultiStateltems ns=3;s=MultiStateltems i -1
0 StaticArrayVariables ns=3;s=StaticArrayVariables i -1
() staticvarizbles ns=3:s=StaticVariables o 1
OTwostateItems ns=3;5=TwoStateltems i -1
ONonUaNodeCOn'lplianceTest ne=4:s=NonlaNodeComplianceTest [} -1
OSimulation ns=5;5=85/0:Simulation { -1
OMyBigNodeManager ns=6;5=MyBiglodeManager i -1

In the resulting Confirmation dialog, click Yes.

4% Confirm M

® Add Child Points
Yes ; No

This adds a point folder and control points for all of the child OPC UA variables.

NOTE: Clicking No in the dialog adds only the point folder.

The added point folder in the database pane is configured to match the variables in the discovered
OPC UA folder.

NOTE: The show All Descendants !" icon on the tool bar must be selected to show the child
points, as shown here.

-

. Station (OPCUA) : Config . Drivers . OpcUaNetwork . OpclaDevice -.._atPoint Manager =
Database 26 objects
Name Type Out Ua Node Id Array Index Ua Statu B
0 Boolean Boolean Writable true{ok} @ def ns=3;5=Boolean GOOD (0x00(
0 Byte NumericWritable 0{ok} @def ns=3;5=Byte GOOD (0x00(
e DateTime String Writable 11/04/1605:51:13.5730000 GMT {ok} @ def ns=3;5=DateTime GOOD (0x00(
0 Double NumericWritable 0.00{ok} @ def ns=3;s=Double GOOD (0x00(
0 Duration NumericWritable 0.00{ok} @ def ns=3;s=Duration GOOD (0x00(
0 Float NumericWritable 0.00{ok} @ def ns=3;s=Float GOOD (0x00(
e GUID String Writable 35b08e32-397c-480e-a83-8901e75d4334 ok} @ def ns=3;5=GUID GOOD (0x00(

[

% © U B X ElvW|RD /s 0 M

[©)

Q

All Descendants: Show all descendants or just immediate children
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Related Links

e Opc Ua Client tasks (Parent Topic)

Importing OPC UA Histories without using a Control Point

The OpcUaDevice component’s “Histories” OpcUaClientHistoryDeviceExt component provides the
ability to import OPC UA histories without creating a control point.

WARNING: Be aware that it is possible to duplicate an OPC UA History import by unintentionally
using both the OpcUaClientHistorylmport and a Control Point with an ImportHistoryExt for the same
discovered object. See “Adding Points that also have OPC UA Histories”.

Perform the following steps:

1. Inthe Nav tree, right-click on Histories under the OpcUaDevice and click Views > Opc Ua Client
History Import Manager, as shown.

e Drivers

O nizzaratietworl@aTe Device Histories View

Views » | OpcUa Client History Import Manager

 opcusnetwork New AX Property Sheet
= HEW -
Wire Sheet

¢ Edit Tags
Property Sheet

Make Template

Relation Sheet

New View

2. In the view, click Discover and wait a few moments for the job to run.
On completion, a list of histories will be listed in the Discovered pane.

° /‘ Ndriver Discovery Success )} E]
Discovered 10 objects
Ua Display Name  Ua Node Id Array Dimension  Array Index Node Class Description Type Spec Ua Data Type Ua Data Type ldentifier UaVa B

oA MyLevel ns=2;5=MyLevel Variable baja:Double  Double 11 23.0

Q MySwitch ns=2;5=MySwitch Variable baja:Boolean  Boolean 1 falze

i Counterl ns=5:5=Counterl Variable baja:Double  Int32 g 26

A Expressionl  ns=5;s=Expressionl Variable baja:Double  Double 11 3.8747
Database 0 objects
Name Historyld Status State LastSuccess Ua NodeMame UaModeld TypeSpec LocalHistory Name B

D New # Edit n Discover B Cancel {E}Add >0 Match #ii Archive B Tagit

3. In the Discovered pane, select one or more histories to be imported and click Add.
4. In the Add dialog, modify properties to setup the history import as desired and click OK.
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r B
4% Add [

Name History Id  Execution Time Enabled Capacity FullPolicy Ua MNodeName Ua Node
& ns=2;5=MyLevel 2:00 AM {Sun Mon Tue Wed Thu Fri Sat}  true Unlimited Roll MyLevel ns=2;s=M
2 ns=2;5=MySwitch 2:00 AM {Sun Mon Tue Wed Thu FriSat} true Unlimited Roll MySwitch ns=2;5=M
ﬁ Name na=2;3=MyLevel
[l History 1d i /

Time Of Day 02:00:00 BM IST|H
m Execution Time Daily Randomization |[+00000h 00m 00s|3

DaysOf Week  [#] Sun [ Mon [ Tue [@] wed [ Thu [#] Fri [ sat
m Enabled . true
m Capacity Unlimited
[l Full Policy Roll
m Ua Node Name MyLevel ;_?
m Ua Node Id ns=2;s=Mylevel ;_?
m Type Spec baja:Double K_? fl
[l Local History Name | ns$3d2$3bss3dMyLevel Al

OK Cancel

The histories are imported to the station’s history database at the time specified in the Execution
Time property shown above.

Related Links

Opc Ua Client tasks (Parent Topic)

Subscribing for OPC UA Alarm Events

The OpcUaDevice component's “Alarm Ext” OpcUaClientAlarmDeviceExt component provides the
ability to subscribe to OPC UA alarm events.

Perform the following steps:

1.

2.

In the Nav tree, right-click on Alarm Ext under the OpcUaDevice and click Views > Opc Ua

Client Alarm Manager, as shown.
In the view, click Discover . It will scan the Opc UA server looking for OPC UA Variables that are

“alarmable”.
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° /‘ Mdriver Discovery Success >) E]
Discovered 1 objects
Uz Display Name Ua Node Id Array Dimension  Array Index MNodeClass Description TypeSpec  Ua Data Type Ua Data Type ldentifier UaValue B
@MyLevel ns=2;s=MyLevel Variable baja:Double Double 11 23.0 Dai
Database 0 objects
MName UaMNodeld Enabled Subscribed Last Event B
B New | Il‘ Edit n Discover | M Cancel @ Add » Match ?‘o Taglt
- |
3. In the Discovered pane, select the variable to be imported and click Add.
4. In the Add dialog, modify properties as desired and click OK.
(42 Add =Sc=)
Name Ua Node Id Enabled i
& MyLevel nz==2;s=Mylevel true
ﬁ Name MyLewvel
m Ua Node Ild ns=2;s=Mylevel :_E
m Enabled . true
oK Cancel
An OpcUaClientAlarmSource component is added to the station database.
° /‘ Ndriver Discovery Success >> E]
Discovered 1 objects
Ua Display Name  Ua Node Id Array Dimension  Array Index MNodeClass Description Type Spec  Ua Data Type Ua Data Type Identifier UaValue B
o MyLevel ns=2;s=MyLevel Variable baja:Double Double 11 23.0 Dot
Database 1 objects
Name Ua Node Id Enabled Subscribed Last Event i

IiMyLevel ns=2;s=MyLevel true true

New # Edit Discover M Cancel Add Match e Taglt
. %

NOTE: The Last Event column displays a summary of the last alarm event received from the
OPC UA Server for the specified OPC UA node.
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5. The added OpcUaClientAlarmSource contains an AlarmSourcelnfo component. The
AlarmSourcelnfo can be configured to route the received Opc Ua Alarm Events to Alarm

Recipients.

Property Sheet

[l MyLevel {OpcUa Client Alarm Source)
(@ Status {ok}
(Ml Enabled ® e
(@i UaNodeld ns=2; s=MyLevel
(M subscribed ® true
m Last Event 07-Nov-16 3:29 PM IST ns=2;s=Mylevel.lla:
© Alarm Source Info  Alarm Source Info

[ Alarm Class Default Alarm Class
iparent.displayName% @

m Source Name

Ul To Fault Text @

The Enabled property is used to subscribe or unsubscribe to receive Opc Ua Alarm Events on
the given OPC UA Node.

When a new OPC UA alarm event is received it will be routed through the specified AlarmClass
in the station’s Alarm Service. It is then treated as any other alarm.

Related Links

e Opc Ua Client tasks (Parent Topic)

Related References

e opcUaClient-OpcUaClientAlarmDeviceExt
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Related Links

About the security architecture

Point type mapping

Point facet mapping

OpcUaServer alarm processing

OpcUaServer alarm acknowledgment processing

Third-party simulation software

Components and views

About the security architecture

Figure 1. OPC UA Security Architecture

QPC UA Client

Application Layer
« User Authorization
+ User Authentication

Session
o= - = = -

OPC UA Server

Application Layer
s User Authorization
+ User Authentication

B

Communication Layer <
+ Confidentiality

+ |ntegrity

* App Authentication

Secure Channel

>

Communication Layer
+ Confidentiality

+ Integrity

+ App Authentication

Transport Layer

The following topics provide conceptual information on the OPC UA security architecture, including
descriptions of the security policies, security mode, security profiles and user authentication.

Also covered is information on point type and facet mapping, server alarm processing and alarm
acknowledgment processing, links for third-party simulation software, as well as descriptions of the
components and views present in the opcUaServer and opcUaClient modules.

The OPC UA security architecture is structured in an application layer and a communication layer on
top of the transport layer, as shown here.

The routine work of a Client application and a Server application to transmit information, settings,
and commands is done in a session in the application layer. The application layer also manages the
security objectives user authentication and user authorization. The application layer communicates
over a secure channel that is created in the communication layer and relies upon it for secure
communication. The secure channel provides encryption to maintain confidentiality, message
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signatures to maintain integrity and digital certificates to provide application authentication for data
that comes from the application layer and passes the “secured” data to the transport layer.

Related Links

e Security policies
e Security mode
[ ]
[ ]

Security profiles
User authentication

Opc Ua Reference (Parent Topic)

Security policies

A security policy specifies which security mechanisms are to be used in OPC UA. Security policies are
used by the Server to announce which mechanisms it supports and by the Client to select one to use
with the secure channel it wishes to open.

Security policies include the following information:

¢ algorithms for signing and encryption
e algorithm for key derivation

The choice of security policy is normally made by the administrator typically when the Client and
Server products are installed. The available security policies are listed below

¢ None — This defines a policy for configurations with the lowest security needs. This policy will
result in NO channel security during communication. The specifications recommend that, by
default this Security Policy should be disabled if any other Security Policies are available.

e Basic128RSA15 — This defines a policy for configurations with medium security. It uses RSA15
as Key-Wrap-algorithm and 128-Bit for encryption algorithms.

e Basic256 — This defines a policy for configurations with medium to high security needs. A suite
of algorithms that are for 256-Bit encryption.

e Basic256SHA256 — The default configuration for OPC UA server and client in Niagara, this
defines a policy for configurations high security needs.

Related Links

e About the security architecture (Parent Topic)

Security mode

The Security Mode is an enumeration that specifies what security should be applied to message
exchanges during a session. Following are the security modes supported by OPC UA.

¢ None — This security mode means No security is applied.

¢ Sign — This security mode means all messages are signed but not encrypted. In this mode the
messages are transported as plain text, but the signature or signing the message allows
detection if it has been manipulated by any third party.

¢ Sign and Encrypt — The default configuration for the OPC UA server and client, this security
mode means all messages are signed and encrypted. In this mode the messages are encrypted
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and not transported as plain text. The signature or signing the message allows detection if it
has been manipulated by any third party.

Related Links

e About the security architecture (Parent Topic)

Security profiles

In the Niagara OPC UA implementation the combination for Security mode and Security Policy form a
Security Profile, different Profiles specify different details such as which encryption algorithms are
required for which OPC UA functions. Some of the Profiles specify security functions and others
specify other functionality that is not related to security. The following security profiles are available
in Niagara Opc Ua.

e None
— No security mode or no security profile, NO channel security during commutation.
¢ Sign with Security Policy
— SignBasic128RSA15 — Medium channel security during commutation with message
transported as plain text with a digital signature.
- SignBasic256 — Medium to high channel security during commutation with message
transported as plain text with a digital signature.
— SignBasic256SHA256 — high channel security during commutation with message
transported as plain text with a digital signature.
¢ Sign and Encrypt with Security Policy
- SignEncryptBasic128RSA15 — Medium channel security during commutation with
message transported with a digital signature and encrypted.
— SignEncryptBasic256 — Medium to high channel security during commutation with
message transported with a digital signature and encrypted.
— SignEncryptBasic256SHA256 — High channel security during commutation with
message transported with a digital signature and encrypted.

NOTE: In Niagara the default configuration for OPC UA security mode is Sign and Encrypt with
Security Policy: SignEncryptBasic256SHA256 The other security policies and modes will be supported
within for OPC UA server and client with a warning message on the security risk involved, the User or
Administrator must agree to this and it is logged in the system for audit purposes.

Related Links

e About the security architecture (Parent Topic)

User authentication

Authentication is a security objective that assures that the identity of an entity such as a Client,
Server, or User can be verified. User Authentication is achieved when the client passes user
credentials to the server.

Following is the current set of supported user authentication mechanisms for the Niagara OPC UA
driver:

e Anonymous — Indicates that the client has no user credentials.
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NOTE: Choosing Anonymous will invoke a warning message about the security risk involved.
The User or Administrator must accept the risk and that acceptance is logged in the system for

audit purposes.

e Username/password — The default User Authentication mode, the client passes simple
username and password credentials to the server.

Related Links

e About the security architecture (Parent Topic)

Point type mapping

The following table maps the OPC UA built-in data types to Niagara point types.

OPC UA Data Type Boolean Enum Numeric String
Boolean X

SByte X

Byte X

Int16 X

Uintl6 X

Int32 X

UInt32 X

Int64 X

Ulnt64 X

Float X

Double X

String X
DateTime X
Guid X
ByteString

XmlElement X
Nodeld X
ExpandedNodeld
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OPC UA Data Type

Boolean

Enum

Numeric

String

StatusCode

LocalizedText

ExtensionObject

Variant (array of)

Diagnosticlnfo

Enumeration

Related Links

e Opc Ua Reference (Parent Topic)

Point facet mapping

The OpcUaClient driver will attempt to initialize facets for a point based on the setup of the OPC UA

Variable being proxied.

Control Point

Description

BooleanPoint

Will set the TrueText and FalseText if the OPC UA variable has
"TrueState" and "FalseState" properties.

EnumPoint

Will set the EnumRange if the OPC UA variable has an

"EnumStrings" property.

NumericPoint

Will set the Units if the OPC UA variable has an EUInformation
property and the Unit maps to a system Unit. Will set the
Precision, Max, and Min values based on the OPC UA variable
data type or a "Range" property if it exist for the variable.

Related Links

e Opc Ua Reference (Parent Topic)

OpcUaServer alarm processing

When started, the OpcUaServer automatically adds to the station's AlarmService an
OpcUaServerAlarmClass and an OpcUaServerAlarmRecipient (if they don't already exist). The
OpcUaServerAlarmRecipient is responsible for triggering the OPC UA event from the Niagara alarms

that are routed to it via the linked OpcUaAlarmClass. Alarms routed to the

OpcUaServerAlarmRecipient must come from a control point that also contains an

OpcUaServerProxyExt so that it can be related to a OPC UA Nodeld. The OPC UA Nodeld is a property

of the OpcUaServerProxyExt. The OpcUaServerAlarmRecipient also has an OpcUaSeverity property.
This property is used to map the alarm's AlarmState to OPC UA alarm severity.
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The following image shows the default OpcUaSeverity mapping.

2 Opc Ua Severity 700, 900, 500, 600

© To Offnormal [1 - 1000]
© To Fault [1 - 1000]
© To Normal [1 - 1000]
© To Alert [1 - 1000]

Related Links

e Opc Ua Reference (Parent Topic)

OpcUaServer alarm acknowledgment processing

An OPC UA Client can subscribe and receive OPC UA Events from an OPC UA server. The OPC UA
Client Alarm Manager may allow the user to Acknowledge a received event back to the OPC UA
server. It may also allow the user to command the OPC UA server to Enable or Disable the source of
the received event.

The Acknowledge, Enable, and Disable commands are processed by the OpcUaServer's
OpcUaServerAlarmDeviceExt that is a child of each Namespace component. Each OpcUaServer
Namespace has a frozen slot named AlarmExt that is of type OpcUaServerAlarmDeviceExt. It will keep
track of all of the alarmable points under this Namespace. When an Acknowledge is received for the
OPC UA Client it attempts to locate the alarm record being acknowledged and acknowledge the
alarm. When a Disable command is received it will disable the alarm from generating any more OPC
UA Events from the associated control point until an Enable command is received.

Related Links

e Opc Ua Reference (Parent Topic)

Third-party simulation software

Third-party OPC UA simulation servers and client devices are available for purposes of testing and
evaluation. This section provides a few links.

If installing only the client driver, you will need to identify an Opc UA Server for the client driver to
communicate with. Following are a couple that are available.

¢ Prosys OPC UA Simulation Server download:
https://prosysopc.com/products/opc-ua-simulation-server/

e OPC Foundation Sample Applications download:
https://opcfoundation.org/developer-tools/developer-kits-unified-architecture/sample-
applications/

If installing only the server driver, you will need to identify an OPC UA Client device for the server
driver to communicate with. Following are a couple that are available.

e Prosys OPC UA Client download:
https://www.prosysopc.com/products/opc-ua-client/evaluate/

37


https://docs.niagara-community.com/bundle/OpcUaDriverGuide/page/OpcUaReference-D3DBE7A9.html#OpcUaReference-D3DBE7A9
https://docs.niagara-community.com/bundle/OpcUaDriverGuide/page/OpcUaReference-D3DBE7A9.html#OpcUaReference-D3DBE7A9

Opc Ua Reference

e Unified Automation's UA Expert OPC UA Client download:
https://www.unified-automation.com/downloads/opc-ua-clients.html

Related Links

e Opc Ua Reference (Parent Topic)

Related Tasks

Verifying set up using client simulation software

Components and views

Components include services, folders and other model building blocks associated with a module. You
drag them to a property or wire sheet from a palette. Views are plugins that can be accessed by
double-clicking a component in the Nav tree or right-clicking a component and selecting its view from
the Views menu.

The component and view topics that follow appear as context-sensitive help topics when accessed
by:

¢ Right-clicking on the object and selecting Views > Guide Help
¢ Clicking Help > Guide On Target

Related Links

opcUaServer-OpcUaServer
opcUaServer-OpcUaNamespace
opcUaServer-OpcUaServerPointDeviceExt
opcUaServer-OpcUaServerAlarmDeviceExt
opcUaServer-OpcUaServerDeviceFolder
opcUaServer-OpcUaServerPointFolder
opcUaServer-OpcUaAlarmClass
opcUaServer-OpcUaAlarmRecipient
opcUaServer-OpcUaAuthenticationScheme
opcUaClient-OpcUaNetwork
opcUaClient-OpcUaDevice
opcUaClient-OpcUaBuildInfo
opcUaClient-OpcUaClientAlarmDeviceExt
opcUaClient-OpcUaClientPointDeviceExt
opcUaClient-OpcUaDeviceFolder
opcUaClient-OpcUaClientHistoryDeviceExt
opcUaClient-OpcUaClientPointFolder
opcUaServer-OpcUaServerDeviceManager
Opc Ua Server Alarm Manager

Opc Ua Server Point Manager

Opc Ua Client Device Manager

Opc Ua Client Alarm Manager

Opc Ua Client Point Manager

Opc Ua Client History Import Manager

e Opc Ua Reference (Parent Topic)
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opcUaServer-OpcUaServer

OpcUaServer is a network-level component. It contains the device-level OpcUaNamespace
component and configuration parameters necessary for communications with OpcUa client devices.
Additionally, the OpcUaServer point device extension (OpcUaServerPointDeviceExt) of Opc Ua
Namespace is used to add points in the Niagara Opc Ua Server. This component is found in the

OpcUaServer palette.

The OpcUaServer has the standard network component properties such as health and other status
properties (see “About network components” in the Drivers Guide for general information). The
default view for an OpcUaServer is the Opc Ua Server Device Manager.

Properties used to configure the OpcUaServer are listed here:

Name

Value

Description

Opc Ua Server Name

text string

Name of the server- edit this as needed,
or use the default name:
N4OpcUaServer.

Opc Tcp Endpoint

Container for configuration
subproperties

Enabled

true (default), false

Port

52520 (default)

Port number for Opc Tcp connections.

NOTE: The port specified in the Opc Tcp
Connection Address may be blocked by
PC/network firewall. The firewall
settings may need to be adjusted to
allow data transfer on this port.

Security Mode

none, sign (default), signEncrypt (default)

By default, “sign” and “signEncrypt” are
selected.

Security Policies

Basic128Rsalbs, Basic256,
Basic256Sha256

By default, all are selected.

User Authentication Methods

Anonymous

User Name and Password (default)
Certificate (default)

Issued Token (default)

By default, all except Anonymous are
selected. Opc Ua Device settings must
match the server’s settings for a
successful connection.

Note that username and password
values must be defined in the station’s
User Service.

Max Session Count

500 (default)

Max Session Timeout

00001h 00m 00s (default)

Max Subscription Count

50 (default)
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Name Value Description
Opc Tcp Connection Address opc.tep://URL Connection address for the Opc Ua
for example (opc.tcp:// Server. The station must be running for
ABCD1234.global.ds.honeywell.com: this field to be populated. This address
52520/0OPCUA/N4OpcUaServer) includes the specified port number for
the Opc Tcp Endpoint.

Actions
¢ Ping - Sends a ping monitor request to verify device health.
Related Links

e Components and views (Parent Topic)

Related Tasks

Setting up the OPC UA Server

opcUaServer-OpcUaNamespace

OpcUaNamespace is a device-level component that must be added to the OpcUaServer node. The

Namespace provides a standard method for an Opc Ua Server to represent objects to Opc Ua Clients.

It defines objects in terms of variables and applicable attributes. It is typically used to provide a
logical grouping of OPC UA variables, histories, and events that can be accessed by an OPC UA client.

If you intend to add server points to the Opc Ua Server then you must first add a NameSpace
component. Within this Namespace you can discover points on a station and add those points to the
Namespace. Once that is done, an OPC UA Client can connect to the OPC UA Server and subscribe to
all these points for monitoring.

This component is found in the OpcUaServer palette.

The OpcUaNamespace has the standard component properties such as health and other status
properties.

Properties used to configure the OpcUaNamespace component are listed here:

Name Value Description

Name text string Use the default name or enter some
other meaningful name such as HVAC,
etc.

Type text string Opc Ua Namespace is the default type

and the only available option.

Namespace Url text string Use the default url value.

Enabled true (default), false Use to enable/disable this component
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Related Links

e Components and views (Parent Topic)

Related Tasks

Setting up the OPC UA Server

opcUaServer-OpcUaServerPointDeviceExt

OpcUaServerPointDeviceExt (Points) is the OPC UA implementation of PointDeviceExt, a frozen device
extension under every OpcUaServerNamespace. Its primary view is the Opc Ua Server Point Manager.

The Opc Ua Server Point Device Ext (Points) is also available in the opcUaServer palette.

Related Links

e Components and views (Parent Topic)

opcUaServer-OpcUaServerAlarmDeviceExt

This component is a child of each Namespace component. Each OpcUaServer Namespace has a
frozen slot named AlarmExt that is of type OpcUaServerAlarmDeviceExt. It keeps track of all of the
alarmable points under this Namespace.

When an Acknowledge is received for the OPC UA client it attempts to locate the alarm record being
acknowledged and acknowledge the alarm. When a Disable command is received it disables the
alarm from generating any more OPC UA Events from the associated control point until an Enable
command is received.

This component is found in the OpcUaServer palette.
Related Links

e Components and views (Parent Topic)

Related Tasks

Adding a server point with alarm and history extensions

opcUaServer-OpcUaServerDeviceFolder

Opc Ua Server Device Folder is the Opc Ua Server implementation of a folder under the OpcUaServer.
Typically, you add such folders using the New Folder button in the Opc Ua Server Device Manager
view of the OpcUaServer. The component is also available in the opcUaServer palette.

Related Links

e Components and views (Parent Topic)
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opcUaServer-OpcUaServerPointFolder

Opc Ua Server Point Folder is the Opc Ua Server implementation of a folder under an
OpcUaNamespace Points extension. You add such folders using the New Folder button in the Opc Ua
Server Point Manager view of the Opc Ua Server Point Device extension. The Opc Ua Server Point
Folder is also available in the opcUaServer palette.

Related Links

e Components and views (Parent Topic)

opcUaServer-OpcUaAlarmClass

OpcUaAlarmClass is used to group the alarms that have the same routing. It collects the alarms of
OPC UA Server points if the alarm extension is configured. This component is found in the
OpcUaServer palette.

Related Links

e Components and views (Parent Topic)

opcUaServer-OpcUaAlarmRecipient

OpcUaAlarmRecipient is used to route alarms to OPC UA Clients. This also maps alarm conditions to
OPC UA Severity.

This component is found in the OpcUaServer.
Related Links

e Components and views (Parent Topic)

opcUaServer-OpcUaAuthenticationScheme

The OpcUaAuthenticationScheme authenticates the user on an OPC UA Server, and ensures the
password requirements are adhered to. Any new OPC UA user should be associated with this scheme.

The OpcUaAuthenticationScheme component must be added to the station’s Authentication Service.
Then, when creating a new OPC UA specific user, simply configure the user’s authentication scheme
as: “OpcUaAuthenticationScheme”.

NOTE: When making any changes on OPC UA server side, you must disable and then re-enable the
OPC UA Server.
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Property Value Description

Global Password Configuration container Container component for the
subproperties

Password Strength container Container component for the

subproperties configured for a strong
password which requires a minimum of
10 characters; and at least 1of each of the
following characters: lowercase,
uppercase, digit.

Expiration Interval 365d 00h 00m 00s (default) The password is valid for this period of
time.
Warning Period 030d 00h 00m 00s The period of time prior to password

expiration that a warning is issued.

Password History Length 1-10 Configures the number of previously used
passwords to be retained. This setting
restricts the user from reusing a set
number of previously used passwords.
The range is 1-10, with the default being
2.

Related Links

e Components and views (Parent Topic)

Related Tasks

e Configuring the server to support an Opc Ua Client user

opcUaClient-OpcUaNetwork

The OpcUaNetwork is a top-level container component for an OpcUaNetwork in a station. It
represents a network of manageable Opc Ua Client devices. Within a network you can create multiple
Opc Ua Client devices. This network provides a common “Monitor” that is used to monitor the status
of connected OPC UA Servers. This component is available in the opcUaClient palette.

Actions
¢ Ping - A Ping action attempts communication with device and request to verify device health. If
successful, the status is set to ok. If it fails, the status is set to down.
e Learn — Discovers server objects.

e Reset Comm —

Related Links

e Components and views (Parent Topic)

Related Tasks

e Adding the OPC UA Network
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opcUaClient-OpcUaDevice

OpcUaDevice is the device-level component in an OpcUaNetwork, and represents a client connection
to a specific OpcUaServer. It contains configuration parameters necessary for the driver to
communicate with that server. The OpcUaDevice has a Points device extension
(OpcUacClientPointDeviceExt) that contains all subscribed proxy points.

The OpcUaDevice has the standard device component properties such as status and enabled (see
“Common device components” in the Drivers Guide for general information). The default view for an
OpcUaDevice is the Opc Ua Client Manager.

Properties used to configure the OpcUaDevice are listed here:

Name Value Description
Name text string Name of the device - edit this as needed.
Type Type of device

Server Endpoint Url

opc.tcp://URL

for example (opc.tcp://
IE67DTDVYXX.honeywell.com:
52520/0OPCUA/N4OpcUaServer)

Connection address URL for the Opc Ua
Server

Security Mode

Sign Ecript Basic256 Sha256 (default)
Sign Ecript Basic256

Sign Basic256 Sha256

Sign Basic256

Sign Ecript Basic128Rsal5

Sign Basic128 Rsal5

Specifies what security should be applied to
message exchanges during a session.

e Sign Ecript Basic256 Sha256 — All
messages are signed and encrypted.
The signature or signing the message

User Name and Password (default)
Certificate (default)
Issued Token (default)

None allows detection if it has been
manipulated by any third party.
For more details see, Security policies in the
section “About the OPC UA security
architecture”.
Certificate tridium
other
Security Mode Anonymous User authentication mode is Anonymous by

default. For successful connection, these
settings must match OPC UA Server’s User
Authentication settings.

Enabled true (default), false

User Name text string Required when the OPC UA Server’s user
authentication mode is set to User Name
and Password. The username and password
must be defined in the station’s
UserService.

Password text string Required when the OPC UA Server’s user

authentication mode is set to User Name
and Password. The username and password
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Name Value Description

must be defined in the station’s
UserService.

Actions
¢ Ping - Sends a ping monitor request to verify device health.

e Learn — Discovers server objects.
¢ Reset Comm — Enables/disables the device (closes and reopens server connection)

Related Links

e Components and views (Parent Topic)

Related Tasks

Connecting to an OPC UA Server

e Discovering OPC UA Server Points

¢ Adding Points to the Station database

opcUaClient-OpcUaBuildInfo

This component is a child of each OpcUaDevice component. Each OpcUaDevice has a frozen slot
named Server Info (OpcUaBuildIinfo) on the OpcUaDevice component. This component displays read-
only data on the OpcUaServer configured for the device, as shown.

[l Server Info (Opc Ua Build Info)

@l Product Name N4_OpcUaServer

r- Product Uri urn:tridium.com:0PCUA:N40pcUaServer
(Ml Manufacturer Tridium

W Software Version  4.3.58.16

@ Build Number 16

(@ Build Date 05/10/17 18:46:26.2290000 GMT

Related Links

e Components and views (Parent Topic)

opcUaClient-OpcUaClientAlarmDeviceExt

This component is a child of each OpcUaDevice component. Each OpcUaDevice has a frozen slot
named AlarmExt that is of type OpcUaClientAlarmDeviceExt. The default view is the Opc Ua Client
Alarm Manager.

The OpcUaClientAlarmDeviceExt component provides the ability to subscribe to OPC UA alarm

events. The view allows you to scan the connected OpcUaServer for OPC UA variables that are
alarmable”
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Related Links

e Components and views (Parent Topic)

Related Tasks

e Subscribing for OPC UA Alarm Events

opcUaClient-OpcUaClientPointDeviceExt

OpcUaClientPointDeviceExt (Points) is the OPC UA implementation of PointDeviceExt, a frozen device
extension under every OpcUaClient device. Its primary view is the Opc Ua Client Point Manager.

The OpcUaClientPointDeviceExt (Points) is also available in the opcUaClient palette.
Related Links

e Components and views (Parent Topic)

opcUaClient-OpcUaDeviceFolder

Opc Ua Device Folder is the Opc Ua Client implementation of a folder under an OpcUaNetwork.
Typically, you add such folders using the New Folder button in the Opc Ua Client Device Manager
view of the OpcUaNetwork. The component is also available in the opcUaClient palette.

Related Links

e Components and views (Parent Topic)

opcUaClient-OpcUaClientHistoryDeviceExt

The OpcUaClientHistoryDeviceExt (default name Histories) is a frozen device extension of the
OpcUaClient component. It allows the import of historical data from the OpcUaServer into the history
space. Use its default Opc Ua Client History Import Manager view to add OpcUaClientHistorylmport
descriptors.

For general information, see “About the Histories extension” and “History Import Manager” in the
Niagara Drivers Guide.

Related Links

e Components and views (Parent Topic)

Related Tasks

e Adding points containing OPC UA Histories
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opcUaClient-OpcUaClientPointFolder

Opc Ua Client Point Folder is the Opc Ua Client implementation of a folder under an OpcUaDevice
Points extension. You add such folders using the New Folder button in the Opc Ua Client Point
Manager view of the Opc Ua Client Point Device extension. The Opc Ua Client Point Folder is also
available in the opcUaClient palette.

Related Links

e Components and views (Parent Topic)

opcUaServer-OpcUaServerDeviceManager

The Opc Ua Server Device Manager view is the primary view for the OpcUaServer component. The
view allows you to manage OpcUaNamespace components in the station.

To view, either double-click the OpcUaServer or right-click the OpcUaServer and select Views > Opc
Ua Server Device Manager.

Figure 2. Opc Ua Server Device Manager with added OpcUaNamespace

Database 1 objects
Name Type Exts Namespace Url Status Enabled Health 2
; OpcUaMamespace OpclJaMNamespace eo http:/fwww.tridium.com/OPCUA/OpcUaNamespace  {ok} true 0Ok [31-May-17 11:1

B New Folder | 5] New | # Edit &, Tagit

Related Links

e Components and views (Parent Topic)

Opc Ua Server Alarm Manager
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The Opc Ua Server Alarm Manager is the default view of the Alarms device extension
(OpcUaServerAlarmDeviceExt) under these devices. To view, double-click the Alarms extension, or
right-click and select Views > Opc Ua Server Alarm Manager.

Related Links

e Components and views (Parent Topic)

Opc Ua Server Point Manager

Opc Ua Server Point Manager is the default view for the OpcUaServerPointDeviceExt (Points
container) under an Opc Ua Namespace. This is also the default view for any OpcUaServerPointFolder

under the Points container of an Opc Ua Namespace.

Use this view to discover server points that exist in the station which can be mapped to the
OpcUaServerPointFolder. Such server points are visible to a connected OPC UA client. Also, server
points provide live and historical data as well as alarm events.

To view, right-click a OpcUaServerPointDeviceExt or OpcUaServerPointFolder and select Views > Opc
Ua Server Point Manager

Figure 3. Opc Ua Server Point Manager view with discovered points added to station database

ﬂ Logic A OpcUaServerPointFolder E
° /‘ COpclUa Server Discovery Success » B]

Discovered 6 objects
Point Direction Point Type B

slot:/Logic/NumericWritable_01  Export controliNumericWritable
H slot:/Logic/SineWave_01 Expart kitControliSineWave
H slot:/Logic/Multivibrator Expart kitControl:Multivibrator

slot:/Logic/BooleanWritable 01  Export control:BooleanWritable

BRslot:/Logic/Random 02 Export kitControl:iRandom
Database 3 objects
Name Out Ua Node Id Local Point B
0 MumericWritable_01  62.2 {unackedAlarm} @ 16 ns=2:s=points/OpcUaServerPointFolder/MumericWritable_01  slot:/Logic/NumericWritable_

NumericWritable_02 |88.6{alarm,unackedAlarm} @ 16 |ns=2:s=points/OpcUaServerPointFolder/MumericWritable_02 |slot/Logic/NumericWritable

0 BooleanWwritable_01  true ok} @16 ns=2:z=points/OpcUaserverPointFolder/BooleanWritable_01 slot/Logic/BooleanWritable_

2 New Folder | B New | ." Edit n Discover M Cancel @ Add >+ Match @; Taglt

Related Links

e Components and views (Parent Topic)
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Opc Ua Client Device Manager

The Opc Ua Device Manager is the default view of a OpcUaNetwork which helps to access OPC UA
device components. To view, right-click a OpcUaNetwork and select Views > Opc Ua Client Device
Manager.

Related Links

e Components and views (Parent Topic)

Opc Ua Client Alarm Manager

The Opc Ua Client Alarm Manager is the default view of the OpcUaClient AlarmDeviceExt. This view
allows you to scan the OPC UA server to discover and subscribe to OPC UA alarm events.

Related Links

e Components and views (Parent Topic)

Opc Ua Client Point Manager

Opc Ua Client Point Manager is the default view for the OpcUaClientPointDeviceExt (Points container)
under an Opc Ua Device. This is also the default view for any OpcUaClientPointFolder under the
Points container of an OPC UA Device. Use this view to discover available points in order to add them
to your station database.

To view, right-click a OpcUaClientPointDeviceExt or OpcUaClientPointFolder and select Views > Opc
Ua Client Point Manager.

Figure 4. Opc Ua Client Point Manager view with selected discovered point added to station database
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@ * OpcUa Client Discovery

Discovered
Ua Display Name
Bl Objects
O server
Bl Q) MyObjects

= O MyDevice

QMyEnumObject

- MyLevel
oa MyMethod
Q Myswitch

O statichata

Database

Name Type

DMyLevel MumericPoint  88.00{ok}

Ua Node Id

=85

=2253
ne=2:==MyObjectsFalder
ns=2;s=MyDevice
ns=2:5=MyEnumObject
ns=2;s=MylLevel
ns=2:z==MyMethod
ne=2:z=MySwitch

ns=3;5=5taticData

Ua Node Id Array Index

ns=2;s=MyLevel

Success » E]

12 objects

Access Level Array Dimension ArrayIndex Ua Data Type Ua Data Type ldentifier B

{rwhr}

{rwhr}

Ua Status Code  Tuning Policy Name

GOOD (0xD00000C defaultPolicy l

Related Links

e Components and views (Parent Topic)

Opc Ua Client History Import Manager

Opc Ua Client History Import Manager is the default view for the OpcUaClientHistoryDeviceExt
component which provides the ability to discover and import OPC UA histories without the creation

of a control point.

To view, right-click a OpcUaClientHistoryDeviceExt and select Views > Opc Ua Client History Import

Manager.

Integer

Double

Boolean

Figure 5. Opc Ua Client History Import Manager lists discovered points with histories

-1
-1
-1

-1

11

1 objects

B

50


https://docs.niagara-community.com/bundle/OpcUaDriverGuide/page/ComponentsAndViews-D5C57DDD.html#ComponentsAndViews-D5C57DDD

Opc Ua Reference

° /‘ Mdriver Discovery Success >> E]
Discovered 10 objects
Ua Display Name  Ua Node Id Array Dimension  Array Index MNodeClass Description Type Spec Ua Data Type Ua Data Type Ildentifier UaVa B
Q MyLevel ns=2:s==MyLevel Variable baja:Double  Double 11 23.0
@ MySwitch ns=2;=MySwitch Variable baja:Boclean Boolean 1 false
Q Counterl n==5;==Counterl Variable baja:Double  Int32 6 26
QExpressionl n==5;==Expressionl Variable baja:Double  Double 11 3.8747
Database 0 objects
Name Historyld Status State LastSuccess Ua ModeMame UaModeld TypeSpec Local History Name B
» Match #i Archive 5."-\) Taglt

n New .'\ Edit n Discover B cancel G) Add

Related Links

e Components and views (Parent Topic)
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